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 مقدمه
اصل  انیکی بر اینبا چگونگی ایجاد نقشه دو بعدی از قطعه و مجموعه مونتاژی آشنا می شوید. منطق نرم افزارهای مکدر این فصل 

ونتاژی ماستوار است که طراح پس از ایجاد قطعات و مجموعه های مونتاژی مورد نظر خود از تک تک قطعات و مجموعه های 

 اپ کند.نقشه تهیه کند ودر صورت نیاز آن را روی کاغذ چ

 می شوید. Draftingبعدی ساخته شده وارد محیط  3بعدی از مدل  2برای ایجاد نقشه های 

 برای این منظور از مسیر

 Menu -> start -> mechanical design -> Drafting   

 وارد محیط نقشه کشی می شوید. 

   New Drawingپنجره 

 استاندارد نقشه کشی را مشخص کرد. Standardمی توان در قسمت    New Drawingدر پنجره 

 اندازه کاغذ را می توان تعیین کرد. Sheet Styleدر قسمت 

 استاندارد انتخابی نمایش داده می شود. و اطلاعات مربوط به کاغذSheet Style در پنجره زیر

 بودن را مشخص کرد. Landscapeیا  Portraitو در آخر هم می توان 

 می شوید. Drawingید و وارد محیط می کن ok با تنظیم دلخواه

 محیط نقشه کشی نیز دارای دو بخش است 

 فضای نما که همان کاغذ نقشه است و مرز آن با خطوط مشکی مشخص است .1

ا ایجاد می درخت طراحی که در سمت چپ نما یک ساختار شاخه ای قرار دارد که نما ها و سایر جزییات که در فضای نم .2

 ر این قسمت ثبت می شوند.شود برای مدیریت بهتر د

 بعدی مراحل و کارهای زیر را باید انجام داد. 3برای ایجاد نقشه از مدل 

 ایجاد کادر و جدول مشخصات نقشه 

 برای این منظور از مسیر 
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  Menu ->Edit -> Sheet background   

رنگ خاکستری تغییر رنگ داده شوید همان طور که ملاحظه می کنید رنگ محیط کاری به  می Backgroundوارد محیط 

 است.

 راه دارید: 2برای ایجاد کادر و جدول 

 که برای این کار از مسیر  CATIAروش اول: استفاده از جدول و کادر از پیش تهیه شده توسط

 Menu -> insert -> Drawing -> Frame and Title Block  

 را اجرا کنید  Frame and Title block  دستور

   Frame and Title block  دستور

 دارید manage Frame and Title Blockدر پنجره  

  Style of Title Block  هایمی توان یکی از گزینهsample1 یا sample2 .را انتخاب کرد 

 گزینه های زیر را دارید. Actionدر قسمت 

Creation را که انتخاب کردید برای شما ایجاد می کند. کادری: که 

Deletion :حذف می کند. اید را را که ایجاد کرده کادری 

Resize:  ایجاد کرده باشید و سپس اندازه کاغذ را تغییر داده باشید مثلا از  کادریاگر از قبلA3 -> A2  با اجرای این گزینه

 می دهد. تطبیقکادر بندی را با اندازه کاغذ جدید 

Update:  با توجه به تغییرPart .و ورق اطلاعات موجود در کادر و جدول را به روز می کند 

Check By:  با اجرای این دستور پنجرهControllers name شت که در آن نو کننده رامی شود که می توان اسم بررسی  باز

 این اسم در جدول وارد می شود.

Add Revision Block: .جدول بازنگری را به نقشه اضافه می کند 

 Geometry Creationبا استفاده از نوار ابزار  .Geometry Creationایجاد کادر و جدول با استفاده از نوار ابزار  روش دوم:

 .دبه ایجاد کادر و جدول دلخواه می پردازی

 نکاتی در مورد کشیدن کادر و جدول :
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 مختصات گوشه سمت چپ پایین فضای کاغذ صفر می باشد.

 وان از فرمان های نوار ابزاربرای ایجاد  کادر و جدول می ت

 Menu -> Insert -> Geometry creation  

 و نیز از فرمانهای نوار ابزار

 Menu -> Insert -> Geometry Modifications 

 استفاده کرد. 

 استفاده کرد. constraintهای نوار ابزار  گزینهی قرار دادن قیدهای هندسی از ابر

مایش فعال باشد نماد قید های هندسی در محیط نقشه روی موضوعات ن Show constraintدکمه  Toolsاگر در نوار ابزار 

 داده می شود.

ندسی فعال باشد هنگام رسم موضوعات بعضی از قیدهای ه Create Detected Constraintدکمه  Toolsاگر در نوار ابزار 

 به صورت خودکار بر آنها قرار می گیرد.

 استفاده می کنید. Dimensioningدر نوار ابزار  Dimension ستوردر از دبرای اندازه گذاری خطوط کا

ه ها به اندازه را فعال می کنید تا انداز Drive Geometryبار کلیک می کنید سپس گزینه  2برای ویرایش اندازه روی مقدار آن 

 تبدیل شود. پارامتریک

 ایجاد و مدیریت لایه ها

 نید.و قرار دادن موضوعات در لایه های مختلف به نوعی آنها را دسته بندی می کبا ایجاد لایه در این محیط کاری 

 برای ایجاد لایه  دارید:

 کلیک کنید. Noneبر روی Graphic propertiesدر نوار ابزار 

 کلیک کنید. Other Layersبر روی گزینه 

 ضافه شود.کلیک کنید تا لایه جدید در پنجره ا Newبر دکمه  Named Layersدر پنجره 

ام نکث کوتاه و در این پنجره هر لایه با یک نام و یک شماره شناخته می شود برای تغییر نام لایه روی آن کلیک کنید و یک م

 جدید را وارد می کنید.
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 .دموضوعات را در یک لایه مشخص قرار دهی داکنون می خواهی

 انتخاب کنید. Ctrlموضوعات مورد نظر را با 

 لایه مورد نظر را انتخاب کنید.,قسمت لایه ها  GPاز نوار ابزار 

 برای ثبت موضوعات در لایه مورد نظر در فضای سفید کاغذ کلیک کنید.

 برای خاموش کردن لایه ها دارید:

 ابتدا با نوشتن یک گزاره منطقی مشخص کنید که کدام لایه ها روشن باشد برای این منظور:

Menu -> Tools -> visualization Filters 

All visiable .باعث نمایش تمام لایه ها می شود 

 ص کنید.ا لایه هایی که می خواهید روشن باشد با گزاره منطقی مشخیکلیک کنید باید در این پنجره لایه  Newبر دکمه 

 توضیح :

 and :  به طور مثال  اگرlayer1 & layer 10   لایه نمایش داده می شود. 9باشد 

Or  : layer1 or layer 10  نمایش داده می شود. 10یا لایه  1باشد لایه 

باز  یک سند جدید ذخیره کنید. CATDraw.برای اینکه بتوان از کادر ایجاد شده به این روش دوباره استفاده کرد آن را با پسوند 

 کنید از مسیر 

Menu-File-Page Set Up 

 Insertمه مورد نظر را در پنجره ایجاد شده انتخاب کنید بر دکرا انتخاب کنید و فایل   Insert Background Viewگزینه 

 .را تایید کنید Page Set Upکلیک کنید در مرحله آخر پنجره 

 باز کنید  New Fromیک روش دیگر این است که سند ذخیره شده را توسط دستور 

 Openر ز طریق دستوبرای این منظور باید ابتدا ا .بعد از ایجاد کادر و جدول مشخصات حال باید اولین نمای قطعه را ایجاد کنید

 از مسیر

 Menu -> File -> Open  

 .دگردی می بر Draftingاز آن نقشه تهیه کنید را انتخاب و سند آن را باز کنید و سپس به محیط  دیهخوا قطعه ای که می
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 Front Viewدستور 

 را اجرا کنید. Front Viewدستور  Draftingدر محیط 

Menu -> Insert -> Views -> Projection -> Front View 

را   Planeت یا یک تخ( یک وجه windowیا گزینه  Ctrl + Tabقطعه مربوطه شوید )از طریق   Partپس وارد محیط س

ه مراابی به هانتخ متناظر با صفحهانتخاب کنید و روی آن کلیک کنید. به صورت اتوماتیک وارد محیط نقشه کشی می شوید نمای 

 مشاهده می کنید از طریق این دایره می توان جهات دلخواه نما را تعیین کرد.را یک دایره آبی رنگ 

 درجه. 90چهار پیکان جهت برای چرخاندن به اندازه 

 پیکان چرخشی برای دوران به اندازه زاویه ای که نما تعیین می کند.  ود

 دایره وسط برای ثبت نما.

لیک کرده کرا   Set Incrementنحوه تعیین زاویه چرخش دلخواه  بر روی عدد کنار دایره آبی رنگ راست کلیک کنید و گزینه 

 و افزایش زاویه را مشخص می کنید.

Free Hand Rotation: ا دوران داداگر این گزینه فعال باشد می توان با چرخاندن دایره سبز به صورت آزاد و دلخواه نما ر. 

Increment Hand Rotation: .اگر این گزینه فعال باشد به اندازه افزایش تعیین شده دوران پیدا می کند 

 نکته :

خط یا  ، دو خط ، سه نقطه ، یک قطعه و یک Planeبرای انتخاب صفحه نمای اصلی می توان از یک صفحه تخت قطعه ، یک  

 سیستم مختصات استفاده کنید.

 در صورت نیاز میتوان نماهای دیگر را نیز ایجاد کرد برای این منظور دارید:بعد از وارد کردن مدل 

 Projected viewدستور 

Menu -> Insert -> Views -> Projection -> Project View 

 . دشونما، ایجاد می  ی از سهوقتی این دستور را اجرا می کنید با توجه به نمای فعال و محل قرارگیری ماوس یک 

 نکته:

 نمایی است که کارد آن قرمز رنگ است. ,نمای فعال 

 نکته:
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 برای اینکه نمایی را به نمای فعال تبدیل کنید 

 بار کلیک می کنید. دوروی کادر آن  .1

 در درخت طراحی روی نام نما دو بار کلیک کنیدتا زیر خط دار شود .2

 .ب کنیدرا انتخا  Active Viewروی نام نما در درخت طراحی یا مرز نما در محیط کاغذ کلیک راست کنید و گزینه  .3

 

 نکته:

 Third angle Standard یا First angle Standardو گزینه  RC#Sheet1برای تغییر روش اروپایی یا آمریکایی روی  

 را انتخاب کنید.

 Third angle Standard یا First angle Standardمفهوم 

 چیدمان قرار گیری نما های جانبی یک قطعه در اطراف نمای اصلی در یک نقشه با دو استاندارد معرفی می شود

Third angle Standard 

 First angle Standard 

 نکته:

 د.دوبار کلیک کنید همه نماها از حالت فعال خارج می شوند و غیر فعال می شون sheetاگر روی  

 ی کادر نمایتوجه کنید که با حرکت دادن نمای اصلی نماهای جانبی نیز جا به جا خواهند شد. برای جلوگیری از این کار رو

را  Position Independntly of Reference Viewگزینه  View Positioningجانبی راست کلیک کنید  از قسمت 

 .انتخاب کنید

 Auxiliary viewدستور 

Menu -> Insert -> Views -> Projection -> Auxiliary  View 

وند صلی دیده نشاز این دستور برای ایجاد نماهای کمکی استفاده می کنید. در هنگامی که بعضی از موضوعات قطعه در نماهای ا 

 استفاده می کنید. در زوایای مورد نیاز از این دستور برای نمایش آنها در نماهای کمکی

توجه داشته باشید که خط می بایست داخل نمای فعال قرار  این منظور توسط رسم یک خط یک مرجع ایجاد می کنید برای

نمای کمکی در راستای عمود بر خط است. و نیز می توان یک خط خود نقشه )خط قطعه( را به عنوان مرجع انتخاب  و داشته باشد

 کنید.



12 
 
 

 یف کرد.طه نیز نمای کمکی تعرنق دومی توان توسط 

 را انتخاب کنید. propertiesمی توان برای تغییر خصوصیات نمای کمکی روی آن راست کلیک کنید و گزینه 

 دارید:  call outدر سر برگ 

Headشکل سر پیکان : 

Length طول سر پیکان : 

Angleزاویه سر پیکان : 

Size not dependent onنه اندازه نمی باشند ولی با خاموش بودن این گزی : اندازه های اعمال شده وابسته به مقیاس نقشه

 پیکان به نسبت مقیاس اعمال شده کوچک و بزرگ می شود.

 Unfolded viewدستور 

 د.شواز این دستور برای ایجاد نقشه گسترده قطعات ورق کاری استفاده می  

  View form 3Dدستور 

ابسته و Annotationبه همراه  Functional toleranceبا استفاده از این دستور می توان از یک قطعه ایجاد شده در محیط 

تهیه  نقشه ور از آن نمای ایجاد کرده  باشید می توانید با این دستصنمای خا Partدر محیط به آن نما ایجاد کرده و یا اگر از قطعه 

  .کنید

 طریق امکان دارد ایجاد شود: دو هنمای سه بعدی ب

 Annotationهنگام استفاده از دستورات نوار ابزار 

 GSDدر محیط   view / Annotationاستفاده از دستورات نوار ابزار 

و گزینه  پس از ایجاد  نمای دلخواه اگر بر روی کادر آن در محیط کاغذ یا روی نام آن در درخت طراحی راست کلیک کنید

properties  .را انتخاب کنید و گزینه های زیر دراختیار شما قرار می گیرد 

Properties یک نما 

Display view frame شود. نما نمایش داده می قرمز دور: با غیر فعال کردن این گزینه کادر آبی یا 

Lock view.با فعال کردن این پارامتر نمای انتخابی قابل تغییر و ویرایش نخواهد بود : 
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Visual clippingان ن کادر می تو: با فعال کردن این گزینه کادر دیگری در اطراف نمای انتخابی ایجاد می شود با کلیک روی ای

 ا محو کنید.راد این کادر را تغییر داده و آن مقدار از نما که لازم نیست را در خارج از این کادر قرار دهید و نما بعا

Angle شود. چرخاند دوران یک نما باعث دوران نما های دیگر نمی یم کاغذ: نما را حول محور عمود بر صفحه 

Scale.مقیاس نقشه را تعیین می کنید : 

Hidden lines.خطوط ندید را نمایش می دهد : 

Center lines.خط مرکز دایره را نمایش می دهد : 

3D space با فعال بودن این پارامتر خصوصیاتی که در محیط مونتاژ :Assemble مال می ای هر قطعه تعریف شده است اعبر

سر برگ  propertiesروی قطعه راست کلیک کنید و در قسمت  Assembleگردد. برای تعریف این خصوصیات در محیط 

drafting .دارید 

Do not cut in section.هنگام اعمال برش استفاده می شود : 

Do not use when projectی شود.: قطعه در نمای دو بعدی ظاهر نم 

Represented with hiddenقطعه انتخابی در نقشه همراه با خطوط ندید نمایش داده می شود : .(hidden line باید 

 خاموش باشد.(

3D color .رنگ های مدل سه بعدی در محیط دو بعدی نیز اعمال می شود : 

Axis.خط محور موضوعات نمایش داده می شوند : 

Thread شوند.: رزوه نمایش داده می 

Fillets نمی  شوند در صورت خاموش بودن اثری از لبه های گرد ایجاد می نازک ترسیم: خطوط لبه های گرد به صورت خط

 شود.

3D point بعدی در نما نیز نمایش داده می شوند. 3: نقاط ترسیم شده در محیط 

3D wire frame گزینه دهد. بعدی را در نقشه نشان می  3: خطوط و منحنی هایcan be hidden   ر دخطوط قرار گرفته

 پشت قطعه را مخفی می کند.

View name شود.  داده می: نام هر نما در زیر آن نمایش 

Only generated parts larger thanقطعاتی که ابعاد آنها بزرگتر از مقدار وارد شده باشد نمایش داده می شوند. : فقط 
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View generation modeحالت تنظیم می کند. 4در  : نمایش نماها را 

Exact پیش فرض : 

CGR از فایل با فرمت :CGR می گیرد. نقشه 

Approximate.نمای با حد اقل دقت مورد نیاز ایجاد می کند : 

Raster نما ها را به صورت سایه روشن می توان نمایش داد : 

 نکته :

 بعد از ایجاد نما نمی توان استاندارد آن را تغییر داد. 

  Isometric viewر دستو

 با استفاده از این دستور می توان یک نمای ایزومتریک دلخواه ایجاد کرد.

 ک صفحهوجه تخت یا یزاویه جهت دلخواه را تنظیم کنید سپس بر روی یک  3Dبرای این منظور کافی است که در حالت مدل 

 دلخواه کلیک کنید نمای ایزومتری در آن محیط نقشه کشی ایجاد می شود.

 نکته:

 نمای ایزومتریک تهیه شده از یک مجموعه مونتاژی می تواند برای نمای انفجاری دوباره استفاده شود. 

  Visualizationنوار ابزار 
 از دستورات این نوار ابزار استفاده می شود. جهت نمایش بهتر ترسیمات

 Sketcher Gridدستور 

 .شود کاغذ نقشه کشی شطرنجی می 

 Show Constrainدستور 

 قیود استفاده شده در محیط نقشه کشی را مخفی می کند.با غیر فعال کردن این گزینه  

 Display view frame as specifiedدستور 

 روشن بودن این دستور باعث نمایش کادر نما و خاموش بودن آن باعث عدم نمایش این کادر می شود. 
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 Filter generatedدستور 

بعدی  3محیط  بعدی ایجاد شده اند و ترسیمات آورده شده از 2بین ترسیماتی که در محیط  زمایته باعث روشن بودن این گزین 

 می شود.

 Analysis displayدستور 

 جدولی به آدرس زیر موجود است. اندازه گذاری با رنگهای مختلف انجام می شود تفکیک رنگ در 

Menu-> tools-> option-> mechanical design-> drafting-> dimension-> analysis display 

  Offset section viewدستور 

ات ن دادن موضوعشانتوان یک نمای برشی ایجاد کرد در مورد اشکال بی قاعده گاهی لازم است برای  با استفاده از این دستور می

 با خط برش یا خمیده استفاده کرد. یاز مقاطع مواز

 کنید. برای اعمال برش مراحل زیر را طی

 فعال کردن نمایی که می خواهید از آن نمای برش ایجاد کنید.

 دستور را اجرا کنید

قید  3ه کپدیدار می شود  tools palletقطه اول نوار ابزار نیک پروفیل توسط یک خط یا چندین خط ایجاد کنید با ایجاد 

 ی توان برایم     موازی و عمود بودن و زاویه را دارد . قید زاویه جهت را در خلاف جهت حرکت ساعت تعیین می کند از این قید

 .تعیین حرکت صفحه برش استفاده کرد

 موضوعاتی که می توان با آنها قید گذاری کرد و پروفیل برش را مقید کرد عبارتند از : 

 خط از قبل ایجاد شده موجود در نقشه یک .1

 یکی از محور های مختصات  .2

 draftیک خط در محیط  .3

 استفاده کنید. undoاگر در هر مرحله پروفیل احتیاج به اصلاح داشت می توانید از گزینه 

 دوبار کلیک کنید.  profileدر نقطه انتهایی 

 ود.اگر یک کمان را انتخاب کنید خط از مرکز کمان ترسیم می ش
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نید نمای کیک وجه قطعه را انتخاب  Partروش دیگر برای ایجاد نمای برشی این است که دستور را اجرا کنید سپس در محیط 

 برشی ایجاد می شود.

 برای اصلاح دستور کافیست روی آن دو بار کلیک کنید.

زین پروفیل آن را جایگ وبرش ایجاد کرد : با استفاده از این گزینه می توان یک پروفیل جدید برای replace profileگزینه 

 فعلی کرد.

 : از این گزینه برای عکس کردن جهت برش استفاده می کنید.invert profile directionگزینه 

 نکته :

ش را می توان جهت فل  headو  tailرا انتخاب کنید توسط گزینه  propertiesکرده و   RCاگر بر روی خط نمای برشی  

 تغییر داد.

 نکته:

 با دوبار کلیک روی هاشور می توان خصوصیات گرافیکی آن را تغییر داد.

 : section viewهای دستور یتلباقبرخی 

 نیست(  section cutتوان تعیین کرد که کدام قطعه برش نخورد. )این قابلیت در  در برش فایلهای مونتاژی می

 cut in sectionگزینه  edit-> propertiesقطعه مورد نظر را انتخاب کنید سپس از مسیر   assemblyدر محیط 

views .را فعال یا غیر فعال کنید 

 بار روی آن کلیک کنید تا بتوان خصوصیات آن را تغییر داد. دوبرای تعیین نوع هاشور کافی است 

 Aligned section viewدستور 

 از این دستور برای ایجاد برشهای شکسته استفاده می کنید. 

 :دارید یک برش شکسته جادبرای ای

 فعال میکنید. شیدبرش شکسته داشته با خواهیدنمای مورد نظر را که می 

 دستور را اجرا می کنید .

 .شیدپروفیل برش را می ک
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 بار کلیک می کنید . 2در نقطه انتهایی 

 توجه: 

روی این  شود و باقی صفحات متناظر با خطوط برش بر صفحه مبنای نشان دادن برش می شیدلین خطی که می کدر این حالت او

 .صفحه تصویر می شوند

  Offset section دستور
حیح با این تفاوت که فقط مقطع برش را نمایش می دهند که از نظر  نقشه کشی ص می باشد section viewمانند دستور 

 نیست.

  Offset aligned sectionدستور 

شه کشی با این تفاوت که فقط مقطع برش را نمایش می دهند که از نظر  نقمی باشد  Aligned section view مانند دستور

 صحیح نیست.

 Detail view دستور

 تر تهیه کردبیشبا استفاده از این دستور می توان از جزییات کوچک که به راحتی قابل تشخیص نیستند یک نما با بزرگنمایی 

 :برای این منظور باید

 را اجراکنید در این حالت پروفیل شما دایره خواهد بودdetail view دستور

 مرکز دایره نمای جزیی را بر روی نمای مورد نظر انتخاب می کند

 .با درگ کردن با وارد کردن مقدار شعاع محدوده مورد نظر خود را انتخاب کنید

 .مکان نمای جزئیات در ورق نمای جزئیات ایجاد می شود در انتها با مشخص کردن

 نکته:

 .با کلیک راست بر روی آن می توان آن را از نظر مقیاس اصلاح کرد

 نکته:

  .اصلاح نمی شود view  detail ایجاد کرده اید اگر نمای برش را اصلاح کنیدdetail view اگر از نمای برش

 نکته:
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 ایجاد کنیدdetail view یکbroken view می توان آن را از

  Detail view profile دستور

 می توان یک چند ضلعی بسته را به عنوان محدوده نمای جزئیات انتخاب کرد

   Quick detail viewدستور 

ی م       تمام مرز دایره یا چند ضلعی نمایش داده در این است که   quick detail view اب detail view تفاوت دستور

 .شود

   Quick detail view profileدستور 

 quick اب detail view profile تفاوت دستور .می توان یک چند ضلعی بسته را به عنوان محدوده نمای جزئیات انتخاب کرد

detail view profile   می شود تمام مرز دایره یا چند ضلعی نمایش دادهدر این است که. 

 :نکته

 Detail view رگاز یک عمل broken بعدی تاثیر می کند ولی 3استفاده می کند که بر قطعه quick detail وداز نمای 

 بعدی استفاده می کند

 clipping view/view profile دستور

مایش می است که یک نمای جزئی ایجاد می کند که فقط موضوعات مورد نیاز ضروری را نdetail view دستور هیباین دستور ش

زرگنمایی ببا  یک نمای جدیدdetail جایگزین نمای اولیه می شود ولیclipping کهاین است  detail ستور بادهد تفاوت این د

 .می کند بیشتر ایجاد 

 :برای اجرای دستور

 نمای مورد نظر را فعال کنید

 دستور را اجرا کنید

 بسته دلخواه که جزئیات مورد نظر شما در آن باشد را ایجاد کنید sketch یک

 نکته:

 swap می رود می توانید باhidden نباشد به منطقهclipping اگر اندازه ای که روی نمای اولیه وجود دارد در داخل پروفیل

visible spaceآنرا دید  
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 نکته:

انتخاب  section view را از uncling کلیک راست کرده گزینهclipping برای باز گردانیدن به حالت اول می توان روی نمای

 کنید

 .در اینجا صدق می کند quick detail تفاوت ذکر شده برای

  Broken view دستور

ف ول آن را حذطاز بعضی از نقشه ها یک اندازه بسیازر بزگ است برای نشان دادن آن قطعه در نقشه مجبور می شوید مقداری از 

 .ده می کنیداستفا broken view از دستور کنید تا در ورق جا شود برای حذف کردن این قسمت

 :برای اجرای دستور

 نمای فعال را نتخاب می کنید

 دستور را ایجاد می کنید

م می توان در قطعه ای که متناظر با محدودیت اول است کلیک کنید در خطا سبز رنگ نمایش داده می شود که نشان می دهد ه

 عمودی باشد و هم افقی )نقطه حتما باید روی قطعه باشد

  لیک کنید مشخص می شود که محدودیت افقی باشد یا عمودیم که کودر نقطه د

 سپس با کلیک در فضای دلخواه می توان مقدار محدودیت را مشخص کرد

یک در نقاط نشان می دهد که محدودیت افقی مد نظر است سپس با کل 2کلیک کنید با کلیک در نقطه  1مراحل کار ابتدا نقطه 

 نیدمقدار محدودیت  را مشخص می ک 4و  3

 نکته:

 .نمای شکسته را بی اثر کردunbrokenشده را انتخاب و گزینهbroken می توان با کلیک بر روی نمای

 نکته:

 در نمای شکسته ایجاد کرد.broken out,section,quick detail,clippنمی توان 

 Break out viewدستور 

 با استفاده از این دستور می توان یک برش موضعی ایجاد کرد و قسمتی از ماده را بر داشت  
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 برای اجرای این دستور دارید :

 دستور را اجرا می کنید.

روفیل بسته می پبار کلیک کنید یا با رسیدن به نقطه شروع به صورت خود کار  2در نقطه انتها  شروع به رسم پروفیل برش کنید

 شود.

ی است که در بعدی متناظر با نمای 3بعدی را نمایش می دهدحالت نمایش مدل   3ر این مرحله یک پنجره باز می شود که مدل د

 و فلش سبز رنگ مشخص می کند که برش در کدام جهت ایجاد می شود. دآن هستی

 روش زیر می توان عمق برش را مشخص کرد: 3با استفاده از پنجره و 

 کنید )این روش دقیق نیست( dragروی صفحه نارنجی رنگ کلیک کنید و آن را  .1

ظر ندر محیط نقشه کشی همزمان که پنجره باز است می توان در یک نمای خاص که محور مورد نظر یا لبه مورد  .2

این  از بعدی به صورت خود کار عمق برش تغییر می کند 3مشخص است مکان نمای ماوس را روی آن برده در پنجره 

 برش تا مرکز یک سوراخ باشد استفاده می کنید. خواهیدروش برای حالتی که می 

نوان بعدی است را انتخاب می کنید و از آن به ع 3در محیط نقشه کشی یک لبه که متناظر با یک سطح در حالت  .3

 مرجع استفاده می کنید و می توان مقدار عمق برش را با فاصله نسبت به آن تعیین کرد.

 :break outنکاتی در مورد 

 قابلیت اصلاح ندارد  break outپروفیل 

 داشت  break outو هم  brokenنمی توان هم  viewدر یک 

 زیر داشت: نماهایرا روی  break outمی توان 

1. Project view 

2. Auxiliary view 

3. Section view 

 می باشد. break outنمایی که هم اکنون دارای  .4

 را در موارد زیر داشت: break outنمی توان 

1. Section view 

2. Clipping/detail 

3. Broken 
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 دو روش وجود دارد:  break outبرای حذف 

 را انتخاب کنید. remove break outدر نمای مورد نظر  کلیک راست کنید و گزینه  .1

Rc -> front view object-> remove break out 

 removeو سپس  generated item view کلیک راست کنید و گزینه   break outروی لبه بوجود آمده از  .2

break out  را انتخاب کنید . فقط اینbreak out .از بین می رود 

 نکته:

دیگر را  را انتخاب کنید و سپس نمای  apply break outدارد راست کلیک کنید و گزینه   break outاگر برروی نمایی که 

 را در نمای مورد نظر دید. breakمی شود در واقع می توان اثر  break outدارای انتخاب کنید آن نما نیز 

قطعه به  3D viewer: درصورت فعال بودن این پارامتر با قرار دادن ماوس بر روی هر یک از نما ها در صفحه  animateگزینه 

 همان حالت نمای دو بعدی ظاهر می گردد.

 

 View wizardدستور 

ر ستون د view wizardاین دستور می توان به صورت هوشمند نماهای مختلف قطعه را بدست آورد. در پنجره با استفاده از 

و  نام نما ها سمت چپ می توان نوع نما کلیدی را مشخص کرد که با کلیک روی آن می توان آن را انتخاب کرد بعد از ظاهر شدن

ا زده و به ر  nextکردن روی آنها محل آنها را تغییر داد پس دکمه  محل آن ها در پنجره سمت راست می توان با کلیک و درگ

یک را  رد و محل هرمرحله دوم می رویم در اینجا می توان با استفاده از ستون سمت چپ نما های دلخواه را به حالات قبل اضافه ک

 مشخص کرد.

 ه:نکت

 نماهای انتخاب شده در مرحله اول را حذف می کند. clear previewگزینه 

  نکته:

minimum distance between each view .کمترین فاصله بین نما های مختلف را معیین می کند 

ه صورت وابسته انتخاب می کنید و باقی نما ها ب frontیک سطح را به عنوان نمای  finishسپس بعد از اتمام این مراحل و زدن 

 ایجاد می شوند به آن
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 Dimension نوار ابزار

  Dimensionدستور 

نید کوع اول کلیک برای ایجاد اندازه کافی است روی موض از این دستور برای ایجاد اندازه استفاده می کنید د رمحیط نقشه کشی 

 .ی دهدم   ( را قرار و اگر لازم بود روی موضوع درم این دستور به صورت خودکار اندازه متناسب )فاصله و زاویه و...

 .می توان نوع اندازه گذاری را مشخص کردtools plate در نوار ابزار

1. Projected  

2. force dimension element اندازه یک المان 

3. force horizocal  اندازه افقی 

4. force vertical  اندازه عمودی 

5. force alony direction  اویه زبا یا مبنای انتخابی و  یانتخابی مواز د بر مبنا یواندازه در یک جهت خاص عم

 .به آن اندازه را قرار می دهدنسبت  مثبت 

6. trueleryth dimension  ه را قرار در حالت ایزومتریک نوع اندازه گذاری به صورت حقیقی است. مقادیر واقعی انداز

 می دهد

7. intersection point  دهد اندازه را از محل برخورد دو موضع است قرار می 

 : درس

 ست کلیک کنید و گزینهرا مورد نظر یک موضوع کافی است روی موضوعواقعی روی  غیر مقدار  اندازه ای قرار دادنرب

properties تمسقرا انتخاب کنید در valueگزینه fake dimension تمسقرا فعال کنید و در main value   مقدار

 .وارد کنید اندازه مورد نظر را 

  Chained Dimension دستور

 : د برای این منظور داریدشواز این گزینه برای اندازه گذاری زنجیره ای استفاده می 

  دستور را اجرا می کنید

 اندازه گذاری زنجیره ای بین آنها باشد را به ترتیب انتخاب می کنید خواهیدسپس موضوعاتی که می 

 .ی صفحه کاغذ کلیک می کنید تا اندازه ما ثبت شودبعد از قرار دادن تمام اندازه ها در نهایت بر رو
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  cumulated Dimension دستور

 د شوی از یک صفر مشخص استفاده می یبرای ایجاد اندازه ها دستوراز این 

 دستور را اجرا کنیدربرای این منظو

 انتخاب می کنیدابتدا موضوع مرجع )صفر( و سپس به ترتیب موضوعاتی که اندازه های آن مورد نظر است را 

 در صفحه کلیک می کنید تا اندازه ما ثبت شوند

 Stacked Dimensionدستور 

 : برای ایجاد اندازه های بالای از این کزینه استفاده می کنید برای این منور دارید 

 دستور را اجرا می کنید

 انتخاب می کنید شیداندازه آن ها را داشته با خواهیدابتدا موضوع مرجع سپس موضوعاتی که می 

 در صفحه کلیک می کنید تا تثبیت شوند

  length/distance Dimension دستور

 استفاده می شود طول یا فاصله برای اندازه گذاری  دستور از این

 Angle Dimension دستور  

  استفاده می شود زاویهبرای اندازه گذاری  دستور از این

 Radius Dimension  دستور

 استفاده می شود شعاع کمانبرای اندازه گذاری  دستور از این

 Diameter Dimension دستور 

 استفاده می شود قطر دایره برای اندازه گذاری  دستور از این

 Chamfer Dimension  دستور 

 : برای اندازه گذاری پخ استفاده می شود برای این منظور دستور از این 

 دستور را اجرا می کنید
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 مورد نظر کلیک کنیدروی پخ 

  Thread Dimensionدستور 

د جوابها و فاده می کنیاز این گزینه برای مشخص کردن نوع رزوه و اندازه استفاده می کنید که  بسته به نمایی که از این گزینه است

 حالات متفاوتی ایجاد می شود.

  Cordinate Dimensionدستور 

 می شود. برای مشخص کردن مختصات موضوعات استفاده

  Hole Dimension Tableدستور 

 از این دستور برای ایجاد جدول سوراخ های موجود در نقشه استفاده می کنید.

 انتخاب می کنید.  Ctrlبا استفاده از کلید  شیددر جدول داشته با خواهیدسوراخ هایی که می 

 نکته: 

 این جدول به موضوعات وابسته نمی شود.

 پدیدار می شود.  Axis sys and Tableدستور را اجرا می کنید پنجره 

 این پنجره شامل موضوعات و گزینه های زیر می باشد.

Axis systemقسمت   : محور مختصات دو بعدی که اندازه ها نسبت به آن سنجیده می شود را مشخص می کند. که می توان در

X .مختصات آن و زاویه آن را مشخص می کند 

         Y            

Angle        

 می توان جهت آن را تغییر داد.  Flipبا استفاده از گزینه 

 Title.یک اسم برای جدول مشخص می کند : 

Columns می توان عنوان و :Lable   و یا  1برای ستون ها مشخص کرد. و اگر می خواهید که ستون ها غیر ازA  وع شود شر

 استفاده می کنید.  Start retrence از دکمه 

X  Y,  مختصات مرکز دایره 
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 می توان مشخص کرد که جدول شامل کدام اطلاعات باشد.  

Diamiter  قطر دایره  

 

Only closed circle.فقط دایره های بسته را به عنوان سوراخ در نظر می گیرد : 

Transpose Table.جای سطر و ستون را عوض می کند : 

Sort Table content.جدول را به ترتیب کم و زیاد مرتب می کند : 

Split Table)جدول را به دو یا بیشتر موضوع تبدیل می کند ) در جدوا هایی که مقادیر زیاد است : 

 Re-route Dimensionدستور 

 با این دستور می توان موقعیت اندازه های ایجاد شده را عوض کرد.مثال:

 ند.تغییر می ک 2کلیک کنید موقعیت اندازه به شکل  2و  1ی کنید و سپس روی دو ضلع روی اندازه یا زاویه کلیک م

 Creat Interruptionsدستور 

 با این دستور می توان خطوط اندازه ای که با هم تداخل دارند را برید.

 Remove interruptionدستور 

 کرد.با این دستور می توان برش های ایجاد شده با دستور قبل را حذف 

 Creat/Modiidy clippingدستور 

 با این دستور می توان یک طرف اندازه را حذف کرد.

 Generation Dimension by stepدستور 

 و خودکار استفاده می شود. اندازه گذاری نقشه به صورت گام به گاماز این دستور برای 

 را اجرا کنید.  Generation Dim by step دستور
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ا قرار می گیرد باز می شود. با توجه به اندازه هایی که پس از اجرای این فرمان روی نم Generation Filter  Dimپس از اجرا 

ان نجره می توپ. در این دهمان اندازه هایی هستند که در ترسیم نمایه ها و... هنگام طراحی مدل کردن قطعات قرار داده بودی

 رار می گیرد.مشخص کرد که کدام یک از اندازه ها روی نقطه ق

اید روی  : اندازه هایی که در محیط کاری ترسیم روی ترسیم های نمایه های قطعات قرار دادهSkatcher constraintگزینه 

 نمایه آنها قرار می گیرد.

3D constraint بعدی مانند 3: اندازه هایی که در محیط های کاریpart   انند بعدی م3روی نمایه های قطعات موضوعات

 فاصله بین در صفحه قرار داده اید روی نمایه آنها قرار می گیرد.

Assembly constraint.اندازه های بند مونتاژی در محیط مونتاژ روی نمای آنها قرار می گیرد : 

Measured constraint اندازه هایی که با استفاده از فرمان های :measure  ه اید روی روی قطعات یا بین قطعات قرار داد

 آنها قرار می گیرد. ینما

Associated with unrepreseniedاندازه موضوعاتی که در نماهای دید نمایش داده نشده اند قرار داده می شود :. 

with design toleranceند.یش داده می شو: اگر اندازه ها حاوی تلرانس باشند این تلرانس ها در کنار اندازه نما 

 دارید: step by stepدر پنجره 

می را  Puseکلید  ه می کنید بعد از هر انداز   Playاز  یجاد اندازه ها را تنظیم کرد پس می توان فاصله زمانی بین ا timoutدر 

 کنید.  Editتا اندازه را  دزنی

Not Generate : .اندازه را پاک می کند 

Transferred :  به نمای دیگر که ما انتخاب می کنید تبدیل می کند.اندازه را 

ه می توانید باز می شود. با فعال کردن گزینه های این پنجر Generated Dim axalysis بعد از تکمیل شدن اندازه ها پنجره 

 م می کنید.تقسیاندازه ها را بررسی کنید. برای این منظور قطعه مربوط را نیز باز کرده و محیط گرافیکی را به دو قسمت 

 Generate Dimensionدستور 

و ه در محیط دبا این دستور می توان از تمام اندازه هایی که در محیط سه بعدی برای طراحی قطعات و مجموعه ها استفاده شد

 .بعدی استفاده کرده

ا از مسیر زیر فعال ر  Filter Before Geneظاهر نگردید گزینه  Dimension Generation dilterدر صورتی که پنجره 

 می کنید.
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Tools→option→mechanical→design→draftiy→generation→dimension gene 

 Generate Ballonدستور 

 با این دستور می توان یک مجموعه مونتاژی را شماره گذاری کرده.

 نکته:

 شماره ها روی نمای فعال ایجاد می شود. 

 نکته: 

 در محیط مونتاژ مجموعه را شماره گذاری کرده باشید. Generate Numberingمی بایست با دستور 

 Axis and Threat نوار ابزار

  Centerline دستور

 این دستور برای ایجاد خط مرکز برای دایره و بیضی استفاده می کنید

  دستور را اجرا می کنید

  دایره یا بیضی مورد نطر را انتخاب می کنید

را نگه ctrl کلید کلیک می کنید و گوشه های آنرا گرفته و اندازه آنرا تغییر می دهیم .اگرcenter line اندازه رویبرای تغییر 

 .دارید انداره یک طرفه تغییر می کند

  Centerline with Referenceدستور

 . خط مرکزی ایجاد می کند که موازی با یک جهت خاص است

  دستور را اجرا می کنید

  د نظر را انتخاب می کنیددایره مور

ن از یک موازی آن باشد .اگر به صورت دایرهای تکثیر دهنده باشد موضوعات می توا center line خواهیدسپس جهتی که می 

 .استفاده کردdirect redrence دایره به عنوان
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  Thread دستور

 . که مرجعی در محیط سه بعدی ندارد با استفاده از این دستور می توان در محیط دو بعدی ررزوه ای ایجاد کرد

 دستور را اجرا  می کنید

ن مشخص کرد که می تواtools pal لبه های دایره ای که نشان دهنده سوراخ یا استوانه هستند را انتخاب می کنید در نوار ابزار

 (رزوه ها خارجی )پیچ ( باشد یا داخلی )مهره

   Thread with Reference دستور

 . آنرا می توان مشخص کرد center line است که جهتthread ماننداین دستور 

  Axis دستور

ط خوری بین دو از این دستور برای ایجاد محور استفاده می کنید دستور را اجرا می کنید و سپس دو خط را انتخاب می کنید مح

  رسم می کند

 Axis line centerline دستور

  ور ایجاد می کنداین دستور به صورت یک خط محور و مح

  دستور را اجرا می کنید

 آنها را رسم می کندaxis و center line دایره ای انتخاب می کنید همزمان

  Area Fill Creation دستور

  از این دستور برای ایجاد هاشور استفاده می کنید

  داریدtool paletc دستور را  اجرا می کنید در پنجره

auto matic   درناحیه مورد نظر به صورت خودکار سطح را هاشور می زندبا کلیک کردن . 

profile selection ابتدا با ید مرز ناحیه هاشور را به صورت دستی و با انتخاب لبه ها مشخص کنید  

 creat datum  شکلغییری در تاگر این گزینه خاموش باشد بین هاشور و مرز انتخابی وابستگی ایجاد می گردد .بنا بر این اگر 

 . ایجاد شود هاشور ها به تبع آن تغییر می کنند

 .را انتخاب کنیدisolatc برای غیر وابسته کردن هاشور کافی است روی آن راست کلیک کرده و گزینه
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 Area Fill Modification دستور

ی کنید را اجرا م ،سپس دستور از این دستور برای اصلاح ناحیه هاشور استفاده می کنید ، ناحیه هاشور خورده را انتخاب می کنید

  هاشور به آن منتقل شود را انتخاب می کنید خواهیدو ناحیه جدیدی را که می 

  Arrowsدستور

 .با استفاده ازاین دستور می تواننید پیکان یا فلش ایجاد کنید

  دستور را اجرا کنید

  موضوع باشد یا یک نقطه در صفحه کاغذبا کلیک اول نقطه شروع پیکان را مشخص کنید که می تواند این نقطه یک 

 غذکه می تواند این نقطه یک موضوع باشد یا یک نقطه در صفحه کا با کلیک دوم نقطه انتهای پیکان را مشخص کنید

  برای اصلاح مکان پیکان بر روی نقاط ابتدایی و انتهایی آن کلیک کرده و سپس محل آنرا تغییر دهید

 add break پیکان بر روی آن کلیک کنید سپس روی نقاط زرد رنگ کلیک راست کرده و گزینهبرای اضافه کردن نقطه شکست 

pointرا انتخاب کیند. 

 add an برای ایجاد نقطه نا پیوستگی و انقطاع روی پیکان کلیک چپ و سپس روی نقاط زرد رنگ کلیک راست کرده و گزینه

interruption را انتخاب می کنید  

 Datum Feature دستور

تخاب شود و از این دستور برای قرار دادن مبنای تلرانس هندسی استفاده می شود بعد از اجرای دستور کافی است موضوعی ان

 . سپس جای تلرانس در نقشه ثابت کنید

 نکته :

ر می ل مثلث ظاهمح اگر بخواهند مثلث پایه را تغییر دهید کافی است بعد از ایجاد مبنا روی آن کلیک کرده مربع زرد رنگی در 

 . می توان شکل مورد نظر را انتخاب کردsymbol shape شود با راست کلیک روی مثلث و انتخاب

 نکته : 

  تغییر داد امی توان حروف مشخص کننده مبنا ر
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 Geometrical Tolerance دستور

 انتخاب کنید دستور کافی است موضوعی رابا این دستور می توان روی موضوعات مختلف تلرانس هندسی اعمال کرد بعد از اجرای 

ی گردد مظاهر geometrical toler تا مربع روی دایره ای ظاهر گردد آنگاه هر کجا که کلیک کنید موقعیت آن ثابت و جدول

 .به صورت مناسب آنرا تکمیل کرد نکه می توا

   Table دستور

 . یجاد کردبا این دستور می توان جدولی با تعداد سطر و ستون دلخواه ا

اد می تعداد سطر و ستون جدول را مشخص کنید . روی یک جای دلخواه نقشه کلیک کنید .جدول ایجtable editor در پنجره

 . شود با دو بار کلیک روی هر خانه می توان متن مورد نظر را در داخل آن نوشت

   Table form csvدستور

 .نرم افزار را وارد محیط نقشه کردبا این دستور می توان جداول از پیش ساخته در 

 : نکته

  را اجرا کنیدfile-desk برای اطلاع از فایل مبنای نقشه دو بعدی از مسیردستور

 : دلیلی که باعث قطع ارتباط بین فایل نقشه و سه بعدی می شود

 عوض کردن مسیر فایل سه بعدی .1

  مخفی کردن فایل سه بعدی .2

 در دسترس نبودن فایل سه بعدی .3

  نام فایل سه بعدی تغییر .4

  دو بعدی را پیدا کرد جع نقشهرمmenu-edit-link روش دیگر برای پی بردن به فایل مبنا نقشه این است که از مسیر

 قطعه مورد نظر را تغییر داد یا دوباره معرفی کرد replace می توان گزینه

  Text دستور

  می شود از این دستور برای ایجاد متن های آزاد و مستقل استفاده

 نکات:

 ن متنی را از برنامه دیگر به این برنامه کپی کردوامی ت .1
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 کرد paste می توان متون پیچیده مانند جداول را در این متن .2

  ای نوشتن متن فارسی می بایست در نرم افزار مریم متن را نوشت و در اینجا کپی کردرب .3

  استفاده می شودshift+enter برای رفتن به خط بعدی از .4

 .دستور را اجرا کنید و در یک جای خالی کلیک کنید در کادری که باز می شود شروع به نگارش کنید

ا کردن کلید کردن آن را جا به جا کرد اگر در حین جا به ج Dragبرای جا به جا کردن متن می توان روی آن کلیک کرد و با 

Shift پایین باشد می توان راحتتر متن را جا به جا کرد 

 نکته:

 برای قرار دادن تصویر دلخواه در نقشه کافی است از مسیر 

Menu-Insert-Picture 

 کردن در جای مناسب قرار دهید. Dragتصویر مورد نظر را انتخاب کنید و آن را با  Openدر پنجره 

  Balloon دستور

 ک محل دلخواهیپس در سب و اانتخ دبه آن بالن بچسبانی خواهیدبرای ایجاد بالن از این دستور استفاده می شود موضوعی که می 

  کلیک می کنید

 Roughness symbol دستور

نید سپس در کبرای ایجاد علامت صافی سطح از این دستور استفاده می کنید دستور را اجرا کنید موضوع مورد نظر را انتخاب 

  پنجره باز شده مقادیر مناسب را وارد کنید

 Text with leader دستور

  ده شودبا این دستور یک متن همراه با پیکان ایجاد می گردد قبل از توضیح دستور بعد لازم است نکاتی چند توضیح دا

بعدی نسبت داد برای این منظور کافی است بر روی 3در محیط نقشه کشی می توان یک متن را به یک پارامتر از محیط قطعه 

را attributc linkeرد نظر را انتخاب کنید و روی آن راست کلیک کنیدذ و گزینهمتن دو بار کلیک کرده و پسپس متن مو

 انتخاب کنید حال به محیط سه بعدی رفته موضوع مورد نظر مثلاً قطر سوراخ لیست شده است پارامتر مورد نظر زا انتخاب کنید و

okی کندکنید حال متن شما به قطر سوراخ وابسته است و با تغییر قطر متن تغییر م  
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  Text replication دستور

وضوعات دیگر مبا فایل سه بعدی ارتباط بر قرار کرده است را به attributc linke توسط این دستور می توان متنی را که توسط

نید و سپس نسبت داد برای این کار در فایل سه یعدی موضوع جدید را انتخاب کنید سپس در محیط دو بعدی دستور را اجرا ک

 . دمورد نظر را انتخاب کرده یک کپی از متن اولیه ایجاد می شود که موضوع جدید جایگزین موضوع قبلی می شو متن

ار ه صورت خودکبا این روش می توان خصوصیاتی چون وزن نام قطعه را در جدول به فایل سه بعدی لینک کرد که با تغییر آنها ب

  تغییر می کند

 نکته :

  ث تغییر به صورت خودکار هنگام اعمال تغییرات می شودروشن بودن پارامتر باع 

Tools_option_general_parameters and measure_measure tools_update_automatic update 

part 

 Datum Target دستور

  این دستور مبنای موضعی ایجاد می کند

 Welding Symbol دستور

 مشخص کنید و استفاده می شود دستور را اجرا کنید و محل جوش را با انتخاب لبهاین دستور برای قرار دادن علائم جوشکاری 

  محل قرار گیری علامت جوش را نیز مشخص کنید و اطلاعات مورد نیاز را پر کنید

  Weld دستور

 پنجره محل جوش کاری را با نشان دادن مقطع جوش مشخص می کند . بعد از اجرای دستور خطوط محل جوش را انتخاب و در

welding editorمقطع جوش و ابعاد آنرا مشخص کنید . 

 :درس

  مسیر زیر را دنبال می کنید drawing کردن فایل قطعه یک open برای

Menu_edit_link 

  را کلیک می کنیدopen کلیک می کنید و گزینه pointed document زبانه  در
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 view(positioning view) مشخص کردن محل

 align views using elements  قطهنمی توان دو نما را با استفاده از یک المان هندسی آنها مانند خط دایره و یا  

  می کنیدRc حرکت دهیم خواهیدبرای این منظور روی نما های مورد نظر که می 

  را انتخاب می کنید  view position _aligen views using گزینه

  جابه جا کنید یک موضوع هندسی را انتخاب می کنید خواهیدروی نمای مورد نظر که می 

  بر روی نما های دیگر نیز یک موضوع هندسی را انتخاب می کنید در ناهم راستای شوند

  در یک جای خالی روی صفحه کاغذ کلیک می کنید

 نکته : 

  اگر موضوع هندسی دایره باشد توسط نقطه مرکزش هم راستا می شود

 نکته:

  ط را انتخاب می کنید باید دو خط موازی هم باشنداگر اگر دو خ 

2- super posing: هیمدو نما را با استفاده از این دستور روی هم قرار می د  

 : برای این منظور دارید

  می کنیدrc جابه جا کنید خواهیدروی نمایی که می 

  را انتخاب می کنیدview position_superposeگزینه

 . جا به جا کنید را انتخاب می کنید خواهیدنمایی که می 

 نمای متحرک روی آن قرار بگیرد را انتخاب می کنید خواهیدنمایی را که می 

set relative positionsبرای جابه جایی نماها استفاده می شود  

 : برای این منظور دارید

 می کنید rc روی نمای مورد نظر

  ا انتخاب می کنیدرview position_set relative positionگزینه
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  خط مشخص کننده جهت نمایان می شود

کی رنگ به برروی مربع مشکی انتهای خط کلیک می کنید تا چشمک بزند در این حالت نمای مرجع را انتخاب می کنید مربع مش

  نمای مورد نظر منتقل می شود

هم افقی  تا هر دو نما متناسب به شیدآنرا میکاکنون روی دسته سبز رنگ که در سمت دیگر خط ظاهر می شود کلیک کرده و 

  شوند

طه حال روی خط کلیک کرده خط شروع به چشمک زدن می کند روی نقطه مرکزی کلیک کرده تا دسته سبز رنگ روی این نق

  قرار گیرد

  دایره وجود دارد که با کلیک کردن روی هر کدام نما به آن نقطه منتقل می شود 9روی نمای مورد نظر 

  کنید می توان محل نما را تغییر دادdrag گر روی خطا

Positin نما را بر حسب نمای مرجع جانمایی می کند  

این  یر داد براینا گرفته شده است را می توان تغیبعوض کردن صفحه ایجاد کننده نما : بعد از ایجاد نما صفحه ای که از آن م

  منظور دارید

 میکنیدrc روی نما مورد نظر

  را انتخاب می کنید view object_modify projectionگزینه

  صفحه جدید را انتخاب می کنیدpart در محیط

 Dimension Properties نوار ابزار

Deimension line 
  با انتخاب یک اندازه نحوه نمایش اندازه را تغییر میدهد

Tolerance description 
  ایجاد کرددر این قسمت می توان بر روی اندازه تلرانس 

Tolerane 
  مقدار تلرانس را مشخص می کند
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 Numerical Properties نوار ابزار
  در قسمت اول واحد اندازه را مشخص می کند و در قسمت دوم دقت اندازه

 Style نوار ابزار
از بغییر برای صورت ت برای هر موضوعی خصوصیتی تعریف شده است به عنوالن مثال نوع رنگ خطوط نوع قلم ارتفاع قلم و..... در

  گرداندن آن به حالت اولیه از اینجا اقدام می شود

 Analyze نوار ابزار

 Show Geometry in all view point دستور

 هده کردمشا dviewer3آیکن می توان به طور سریع مدل سه بعدی نقشه دو بعدی موجود را در پنجره  نبا کلیک کردن روی ای

  Dimension Analyze دستور

مشخص می  total number of می توان اندازه هایی را که با هم تداخل دارند مشاهده کرد . تعداد اندازه های متداخل درسمت

  شود

 ایجاد استاندارد شخصی
 ساخت فولدر در به ادرس زیر:-

E:\users\administrator\LockSettings 

 درا ازمسیر زیر اجرا  می کنی Environment Editorدر محیط -2

Start->Programs->CATIA->Tools->Environment Editor  

 :دبرای داری  valueدر قسمت -3

CATReferenceSettingPath    E:\users\administrator\LockSettings 

 

عبارت  که باید شامل دکنی نیز یک مسیر تعریف می CATCollectionStandardبرای گزینه -4

drafting باشد 

E:\users\my standard\drafting 
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 دتایپ می کنی start-runرا در  cnext -admin عبارت administratorبرای اجرا کردن محیط -5

 ر آن اعمال کنیددو تغییرات مورد نظر را  داستاندارد را باز می کنی-5


